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Important
Do not plug a phone jack (RJ-11) into any Ethernet (RJ-45) port on your adapter. Doing so might damage the device.
You must use twisted pair cables with RJ-45 connectors that conform to FCC standards in the device’s Ethernet ports.

Important
Ne branchez pas une ligne téléphonique dans aucuns des port de réseau (RJ45).

Caution

For use with UL Listed, CSA and GS approved personal computers.
Not intended for use in machinery, medical, or industrial applications.
For indoor use only.

Avertissement

N'utiliser qu’avec des composantes homologuées UL, CSA ou TUV.

Ne pas utiliser ce dispositif dans une application industrielle ou médicale.
N'utiliser qu’a l'intérieur.

Information in this document, including URL and other Internet Web site references, is subject to change without notice. Unless
otherwise noted, the example companies, organizations, products, domain names, e-mail addresses, logos, people, places and events
depicted herein are fictitious, and no association with any real company, organization, product, domain name, e-mail address, logo,
person, place or event is intended or should be inferred. Complying with all applicable copyright laws is the responsibility of the user.
Without limiting the rights under copyright, no part of this document may be reproduced, stored in or introduced into a retrieval
system, or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any purpose,
without the express written permission of Microsoft Corporation.

Microsoft may have patents, patent applications, trademarks, copyrights, or other intellectual property rights covering subject matter
in this document. Except as expressly provided in any written license agreement from Microsoft, the furnishing of this document does
not give you any license to these patents, trademarks, copyrights, or other intellectual property.

© 2002 Microsoft Corporation. All rights reserved.

Microsoft, Windows, and Xbox are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or
other countries.

The names of actual companies and products mentioned herein may be the trademarks of their respective owners.
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introduction.

Introducing the Broadband
Networking PCI Adapter

Congratulations on your purchase of the Microsoft® Broadband
Networking PCI Adapter. You can use the adapter to connect any
personal computer with an available PCI card slot to a new or
existing Ethernet network.

Networked computers let you:
Share a broadband Internet connection.
Share files, printers, and other peripheral devices.

Communicate and play games with others on the network or on
the Internet.

This chapter describes your PCl adapter and explains how to
connect it to your network.

Do You Have Everything You Need to Add a
Computer to Your Network?
Included in the Box:
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Also Required (but not included in the box):

Straight-through or crossover Ethernet cable (depending on your
configuration)

System documentation from your computer’s manufacturer

Optional:

A Wake-On-LAN cable (not included)

This is necessary only if you want to use the Wake-On-LAN
feature on an older computer. See “Wake-On-LAN Capability”
later in this chapter for more information.



Your Adapter and Its Connections

Your PCI adapter is connected from within your computer to your
broadband modem or existing network by an Ethernet cable. An
example network configuration is shown in the following diagram.

Active Internet Connection

Broadband Modem

’ (DSL or Cable)
! Base Station
(Router or Gateway)
§'.,1 Computer with
¢ PCI Adapter

There are also other ways to set up your adapter. For an overview
of common setup scenarios, see Chapter 2. For detailed setup
instructions, see Chapter 3.
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About Your PCI Adapter

Your PCl adapter is installed in a standard PCI slot inside your
computer, secured by a metal mounting bracket. The following
diagram shows the layout of the adapter and the location of the
Ethernet port, status indicator light, and Wake-On-LAN connector.
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PCI Connector
Ethernet
Port
PCI Adapter
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After you have completed the hardware and software setup of your
PCl adapter, the indicator light visible through the adapter
mounting bracket provides feedback about network connectivity
and data-transmission speed. As shown in the following table, the
light indicates one of several network states:

Light Status: The PCI Adapter Is:

Off Not connected to an active network.

Solid orange Connected to a 10base-T network running at 10 Mbps.

Blinking orange Activity detected over the 10base-T network.

Solid green Connected to a 100base-T network running at 100 Mbps.

Blinking green Activity detected over the 100base-T network.

Wake-On-LAN Capability

The Microsoft Broadband Networking PCI Adapter includes a Wake-
On-LAN (WOL) feature. WOL technology enables each networked
computer to be “awakened” from a sleep or powered-down state,
allowing it to be accessed from another computer connected to
your local area network (LAN).

When WOL is enabled on a computer, the PCl adapter is powered
and monitoring your network. If another computer or device sends
a message to or tries to access shared files on the WOL-enabled
computer, the PCl adapter tells the computer to power up its other
components.

By using WOL, you can greatly reduce this computer’'s power
consumption while still allowing its shared files and printers to be
accessed over your network.

On most computers, Wake-On-LAN capability can be enabled
through the computer’s BIOS. Some computers might require a
separate, 3-pin WOL cable, available at most computer stores.

To determine whether your computer can take advantage of
Wake-On-LAN features without an extra cable, see your computer
documentation. If your computer lists PCI 2.2 compliance as one of
its system features, you should not need to purchase a WOL cable.

4 Microsoft Broadband Networking PCI Adapter User’s Guide



About Ethernet Connections

Ethernet is the most commonly used wired network protocol, with
connection speeds of 10 Mbps, 100 Mbps, or higher. Your USB or
notebook adapter will transmit data at either 10 or 100 Mbps. The
adapter’s auto-negotiation feature automatically determines the rate
of your network connections and uses the fastest speed available.

As you set up your network, keep in mind that power outlets,
fluorescent lights, power supplies, and coiled or extra-long cables
can interfere with Ethernet transmission and also

produce interference.

Use Ethernet cables to connect your adapter to devices on your
network. Any Ethernet-compatible network device will have one or
more Ethernet ports. Some examples of network devices are:

o Routers, gateways, or base stations, such as the Microsoft
Broadband Networking Wired Base Station

o Broadband modems
o Computers with Ethernet adapters
o Ethernet switches and hubs

Network components such as your adapter are connected to one
another by Ethernet cables. An Ethernet cable resembles a phone
cord, but has larger connectors at each end. To determine whether
a cable is an Ethernet or phone cable, you can count the number of
wires or contacts visible in the connector at either end of the cable.
Ethernet (RJ-45) connectors and cables contain eight wires, and
phone (RJ-11) connectors contain either four or six wires.

R
000000%Y 00
-~
RJ-45 Ethernet RJ-11 Telephone
(8 wires) (4 or 6 wires)
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Straight-Through and Crossover Cables

Data is sent and received through specific wires within an Ethernet
cable. Depending on the arrangement of its sending and receiving
wires, an Ethernet cable is either a “straight-through” type or a
“crossover” type. The following diagram demonstrates how to
differentiate between the two types.

2345678
~ 0

In a straight-
Straight-Through 02345678 through cable,

Ethernet Cable the order of the
colored wires is the

same at both ends.

36@78245
In a crossover
Crossover 02345678 cable, the order of

Ethernet Cable the colored wires
is different at

both ends.

Your adapter supports both straight-through and crossover cables.
For more information on the type of cable you need, see Chapter 2.

Connecting to Broadband Modems

When you connect your adapter to a broadband modem, it is
important to use either the cable that came with your modem or
the same type of cable. Many modems use a crossover cable to
connect to the network. If you are unsure about the type of Ethernet
cable to use, see the documentation for your broadband modem.

6 Microsoft Broadband Networking PCl Adapter User’s Guide



planning.

Planning Your Network

You can use your Microsoft® Broadband Networking Ethernet
adapter within an existing network or to create a new network.
This chapter will help you locate setup instructions for your
network configuration.

Which Setup Option Best Matches Your Network?

The following options describe common ways to use your Ethernet
adapter. Select the one that best matches your networking goals.

Option A:
| want to add another computer to an existing network
that has a base station (gateway or router).

If your computers meet all of the following conditions, see the
Typical Setup method in Chapter 3 to set up the adapter.

You have an existing Ethernet network that has a base station
(gateway or router), a broadband modem, and an active
Internet connection.

The computer you want to add has an available PCI slot.

After you set up the adapter by using Option A, your network will
resemble this diagram:

Active Internet Connection

Broadband Modem
(DSL or Cable)

Base Station
(Gateway or Router)

Computer with

%,‘. PCI Adapter
Installing the software
on this computer
configures the adapter.



Security Considerations for Option A

In this configuration, your networked computers use a base station
(gateway or router) to connect to the broadband modem and,
indirectly, the Internet. A base station can help provide security for
your network by using a hardware firewall or Network Address
Translation (NAT) technology. It is important to enable the
protection provided by your network to prevent security problems.
For more information about security, see chapter 4.

Option B:
| want to connect two computers directly to each other.

Your adapter can be used to network computers by using a “peer-
to-peer” or “computer-to-computer” configuration.

If your computers meet all of the following conditions, use the
Computer-to-Computer Setup method in Chapter 3.

o One computer has an available PCI slot for your new PCI
adapter.

o A second computer already has an installed Ethernet adapter
(or internal Ethernet card).

o You have a crossover Ethernet cable for connecting the two
computers.

After you set up the adapter by using Option B, your network will
resemble this diagram:

“1. A —
Computer with Computer with
PClI adapter installed Ethernet

adapter (notebook
adapter shown)

Security Considerations for Option B

You can access the Internet by connecting one computer to your
broadband modem and sharing the connection with the other
computers by using Internet Connection Sharing (ICS) software.
For more information about ICS, see Windows Help.

Any network that connects to the Internet needs protection from
hackers and viruses. You can use firewall software, such as
Internet Connection Firewall that comes with Windows XP, to help
protect your network from unwanted intrusions.

If your network is not connected to the Internet, you do not need to
worry about protecting your network from Internet intrusions.

8 Microsoft Broadband Networking PCl Adapter User’s Guide



Option C:
| want to connect three or more computers by using a
switch or hub.

You can also create a computer-to-computer network of more than
two computers by connecting them through a switch or hub.

If your computers meet all of the following conditions, use the
Computer-to-Computer Setup method in Chapter 3.

o One computer has an available PCI slot for your new PCl adapter.

o All other computers already have an installed Ethernet adapter
(or internal Ethernet card).

o You have one or more switches or hubs, with enough available
ports to connect each computer in the network.

o You have a straight-through Ethernet cable for each computer on
the network.

After you set up the adapter by using Option C, your network will
resemble this diagram:

Computer with
PCI adapter

E’: i v Switch or Hub

Computers with
installed Ethernet
adapters

Security Considerations for Option C

You can access the Internet by connecting one computer to your
broadband modem and sharing the connection with the other
computers by using Internet Connection Sharing (ICS) software. For
more information about ICS, see Windows Help.

Any network that connects to the Internet needs protection from
hackers and viruses. You can use firewall software, such as
Internet Connection Firewall that comes with Windows XP, to help
protect your network from unwanted intrusions.

If your network is not connected to the Internet, you do not need to
worry about protecting your network from Internet intrusions.

Chapter 2: Planning 9



Option D:

| want to connect another computer to a Home Phone
Line (HomePNA) Network or Power Line Communication
(PLC) Network.

To add a computer to a HomePNA or PLC network by using a
Microsoft Broadband Networking Ethernet adapter, you need to
purchase a HomePNA-to-Ethernet or PLC-to-Ethernet adapter. For
more information about connecting to this kind of network, see the
documentation for your HomePNA or PLC network or contact the
manufacturer’s support services.

To set up your adapter on a HomePNA or PLC network, see
“Connecting an Adapter Using Plug and Play” in Chapter 3. You do
not need to run the Setup Wizard, but you will need to configure
your network settings on the newly networked computer.

Security Considerations for Option D

Any network that connects to the Internet needs protection from
hackers and viruses. How you decide to protect your HomePNA or
PLC network depends on how the network connects to your
broadband modem and to the Internet.

Check that your networking hardware includes a firewall or Network
Address Translation (NAT) software between all networked
computers and the Internet.

Option E:
| have already connected my adapter and have not yet
installed the software.

If you have already connected the adapter and have not yet
installed the software, or you do not want to run the Setup Wizard,
see “Setting Up an Adapter by Using Plug and Play” in Chapter 3 for
setup instructions.

10 Microsoft Broadband Networking PCl Adapter User’s Guide



setting up.

Installing, Connecting, and
Configuring Your Adapter

Your Microsoft® Broadband Networking Ethernet adapter can be set
up in various ways, depending on how your existing network is
configured. The instructions in this chapter will guide you through
the process of setting up your adapter.

Before You Begin

Before you install your PCl adapter, make sure that you have the
following items at the computer:

Included in the Box:
Microsoft Broadband Networking PCl Adapter
User’s Guide

Setup CD-ROM

Also Required (but not included in the box):

Ethernet cable

System documentation from your computer’s manufacturer

Optional:

Network settings provided by your Internet service provider
(ISP). You might need this information during setup, depending
on how you install and configure your adapter.

Microsoft Windows® Setup CD-ROM. This might be necessary if
you need to install any additional Windows networking
components during setup and configuration.

A Wake-On-LAN cable. This optional cable is purchased
separately and is necessary only if you want to use the Wake-
On-LAN feature on an older computer. For more information,
see Chapter 1.



[= Note Typical Setup

If your computers are . . . - .
running Microsoft Windows Follow the detailed instructions beginning on the next page if your

XP or Windows 2000, you existing network configuration matches all of the following

must be a member of the conditions:

Administrator group to set . .
group o You have an existing Ethernet network that has a base station
up a network. If you are not

logged on as an (gateway or router), a DSL or cable modem, and an active

administrator, click Start, Internet connection.

;|:225L2§'|3:§A?_2i52i2TE o The Windows-based computer you want to add has an available,

Log on again with an high-powered USB port or a PC Card slot, and the computer is
administrator's name and not already connected to another network.

password. . . . . .
See the setup instructions later in this chapter if:

o Your network is configured in any other way, or

o You have already connected your adapter and have not yet
installed the adapter software.

After you set up your adapter, your network will resemble the
following diagram.

Active Internet Connection

Broadband Modem
(DSL or Cable)

| Base Station
(Gateway or Router)

Computer with
N PCI Adapter
Installing the software
on this computer
configures the adapter.
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Step 1: Install the Software

1. Insert the Setup CD-ROM into the CD-ROM drive of the computer
that you want to connect to your network. If the Setup Wizard
does not start automatically after a few seconds, double-click
My Computer, double-click the drive that contains your Setup
CD-ROM, and then double-click Setup or Setup.exe.

2. In the Setup Wizard, do the following:

o When the wizard asks which device you are installing, click
Network Adapter.

o When the wizard asks which network adapter you are
installing, click PCI Adapter.

3. When the wizard asks you to specify how you want to use your
adapter, select the option that best describes your existing
network and how you will connect to it.

4. When the wizard asks you to install the PCIl adapter on your
computer, shut down your computer by clicking Close.

5. After your computer shuts down completely, proceed to Step 2.

Step 2: Install the Adapter in Your Computer

1. After your computer shuts down completely, disconnect the
power cord from the back of the computer to prevent shock.

2. Remove the cover from your computer. For instructions, see your
computer’s documentation.

3. Locate an available PCI slot on your computer’s motherboard.
4. Remove the protective bracket from the PCI slot.

5. Insert the PCl adapter into the slot as shown in the
diagram, being careful to:

o Line up the connectors on the PCl adapter with the PCI slot,
and press evenly on the top of the card until it is securely
connected to the motherboard.

o Line up the mounting bracket with the appropriate opening
on the back of your computer.

Chapter 3: Setting Up 13



Caution

Electronic components are
sensitive to static electricity.
Always ground yourself before
touching the PCl adapter or

Mounting
Bracket

=-
v

L
Hm\l“"w

g2

PCI Connectors

any other internal components
of your computer.

PCI Slot

6. Screw the bracket of the PCI adapter securely to your
computer’s case.

7. If your computer does not support PCl 2.2 connectivity and you
want to install Wake-On-LAN capability, do the following:

o Connect one end of the Wake-On-LAN cable (purchased
separately) to the connector on the top edge of the PCl adapter.

Caution o Connect the other end to the Wake-On-LAN connector on
Before you attempt to insert your motherboard.

your PCl adapter into the PCI
slot, make sure that the pin
configuration of the slot
matches that of the
connectors on the bottom of
the adapter.

For more information about the location of this connector, see
your computer’'s documentation.

8. Replace the cover on your computer.

Step 3: Connect Your PCI Adapter to the Network

1. Connect one end of the Ethernet cable (not included) to the
network port on the back of your PCI adapter.

2. Connect the other end of the Ethernet cable to an available
Ethernet port on your existing router, hub, switch, or broadband
modem.

3. Reconnect the power cord to the computer, and make sure no
other cables have come loose during installation.

14 Microsoft Broadband Networking PCl Adapter User’s Guide



[=) Note
If you originally logged on to
an administrator account to
begin Setup, make sure that
you log on to the same
administrator account after
you restart your computer.

After you connect your adapter, the back of your computer will
resemble the following diagram.

Step 4: Configure Your Adapter
1. Turn on your computer.

When Windows starts, the Setup Wizard automatically resumes.
2. Continue to follow the instructions in the Setup Wizard.

When you complete the setup, click Finish to exit the Setup
Wizard.

3. Remove the Setup CD-ROM from your CD-ROM drive and keep it
in a safe place for future installations.

4. If your Internet service provider (ISP) requires additional
network settings, such as a static IP address or special software
to access the Internet, configure this now. For instructions, see
your ISP documentation.

Step 5: Test Your Network
To confirm that your network is working properly, do the following:

o Ensure that your connections are working properly by viewing
the status of your network in the Broadband Network Utility. To
learn more about the Broadband Network Utility, see Chapter 5.

o If your network has Internet access, test the connection by
opening your Web browser and visiting a Web site, such as
www.microsoft.com.

If you are having network problems or you cannot connect to the
Internet through your broadband modem, see “Network and
Internet Problems” in Chapter 6.

Chapter 3: Setting Up 15



[S) Note

For more information about
crossover Ethernet cables,
see Chapter 1.

Computer-to-Computer Setup
Use the setup instructions described here if:

o You want to connect two or more computers directly to each
other or indirectly through a hub or switch.

o You want to connect a Microsoft Broadband Networking adapter
to the first computer.

o All other computers to be networked have an installed Ethernet
adapter or a built-in Ethernet port.

You will need an Ethernet cable for each computer you are adding
to your network. You will need a crossover Ethernet cable if you are
connecting two computers directly to each other. You will need a
straight-through Ethernet cable for each computer that connects to
a switch or hub.

Step 1: Install the Software

1. Insert the Setup CD-ROM into the CD-ROM drive of the computer
that you want to connect to your network. If the Setup Wizard
does not start automatically after a few seconds, double-click
My Computer, double-click the drive that contains your Setup
CD-ROM, and then double-click Setup or Setup.exe.

2. In the Setup Wizard, do the following:

o When the wizard asks which device you are installing, click
Network Adapter.

o When the wizard asks which network adapter you are
installing, click PCI Adapter.

3. When the Setup Wizard asks you to specify how you want to use
your adapter, select the option for computer-to-computer setup.

4. When the wizard asks you to install the PCI adapter on your
computer, shut down your computer by clicking Close.

5. After your computer shuts down completely, proceed to Step 2.

Step 2: Install the Adapter in Your Computer

Install the PCl adapter in your computer by following the
instructions in “Step 2: Install the Adapter in Your Computer” in the
“Typical Setup” section at the beginning of this chapter.

16 Microsoft Broadband Networking PCl Adapter User’s Guide



= Note

If you originally logged on to
an administrator account to
begin Setup, make sure that
you log on to the same
administrator account after
you restart your computer.

Note

Workgroup names are used

to group networked computers
in Windows Network
Neighborhood or My Network
Places (depending on your
operating system).

Step 3: Connect Your Adapter to the Network
Do one of the following:

o

If you are connecting two computers directly to each other,
connect one end of a crossover Ethernet cable to the network
port on the computer that you are adding to the network. Then
connect the other end to an available port on the other
computer.

If you are connecting three of more computers to a switch or
hub, connect one end of a straight-through Ethernet cable to the
network port on the computer you are adding to the network.
Then connect the other end to an available port on the switch or
hub. Connect the remaining computers to your switch or hub.

Step 4: Configure Your Adapter

1.

Turn on your computer.

When Windows starts, the Setup Wizard automatically resumes.

. Follow the instructions in the Setup Wizard to set up file and

printer sharing.

For more information about sharing files and printers, see
Chapter 4.

. To quit Setup and start the Microsoft Broadband Network Utility,

click Finish.

. Remove the Setup CD-ROM from the CD-ROM drive and store it

in a safe place for future installations.

. If your Internet service provider (ISP) requires additional network

settings such as a static IP address or special software to
access the Internet, configure this now. For instructions, see
your ISP documentation.

Step 5: Test Your Network
To confirm that your network is working properly, do the following:

o

Ensure that your connections are working properly by viewing
the status of your network in the Broadband Network Utility. To
learn more about the Broadband Network Utility, see Chapter 5.

If your network has Internet access, test the connection by
opening your Web browser and visiting a Web site, such as
www.microsoft.com.

If you are having network problems or you cannot connect to the
Internet through your broadband modem, see “Network and
Internet Problems” in Chapter 6.

Chapter 3: Setting Up 17



=) Note For Windows 98 Users
If you have any problems )
connecting to or using your If you cannot access other computers on your network, you might

network, see Chapter 6. need to set up a static IP address on your computer.

Some ISPs provide each computer on their network with a
permanent, or static, IP address, which uniquely identifies your
computer on the Internet. When you use a static IP addressing
scheme, each computer on your network requires a unique IP
address provided by your ISP. Because of this, the Setup Wizard
cannot automatically determine this static address and configure
your network for Internet access.

To verify and configure your network IP address, do the following:
1. Click Start, point to Settings, and then click Control Panel.
2. Double-click Network.

3. Under The following network components are installed, click
TCP/IP, and then click Properties.

4. In the TCP/IP Properties dialog box, click IP Address.

If a static IP address appears in the IP address list, you do not need
to configure one. For more troubleshooting steps, see Chapter 6.

If a static IP address does not appear in the IP address list, follow
the instructions below to choose and configure a new IP address.

Choosing an IP Address
IP addresses for internal networks are written as 192.168.X.Y,
where X and Y can be any number from O through 255.

For each computer on your network, select an IP address by
choosing values for X and Y. Write down the IP address of each
computer in a safe place, to help with configuration in the future.

Tip: Use the same number for X on each computer on the network,
and start Y with 10, increasing the number by one for each
additional computer. Using this scheme, your IP addresses would
read: 192.168.1.10, 192.168.1.11, 192.168.1.12, and so on.

To Configure a Static IP Address
1. Click Start, point to Settings, and then click Control Panel.
2. Double-click Network.

3. Under The following network components are installed, click
TCP/IP, and then click Properties.

4. In the TCP/IP Properties dialog box, click the IP Address tab.

5. In the IP Address field, type the new IP address for this
computer.

6. Click Apply to save your changes, and then click OK.

7. When prompted, restart your computer.

18 Microsoft Broadband Networking PCl Adapter User’s Guide



After Windows starts, try testing your network again by using the
instructions in “Step 5: Test Your Network,” above.

If you are still having problems connecting to your network, see
“Network and Internet Problems” in Chapter 6.

Setting Up an Adapter by Using Plug and Play

Most Windows-based computers recognize when a new hardware
device has been installed and immediately try to configure it.

The Setup Wizard is designed to walk you through the process of
installing your adapter. The wizard installs the Broadband
Networking Utility, which allows you to monitor, configure, and
troubleshoot your network.

To gain the benefits of the Broadband Networking Utility on your
network, run the Setup Wizard before installing the adapter in your
computer.

[S) Note ) If you install the adapter on your computer before you run the
If you install your PCI Setup Wizard, the Windows operating system will use its Plug and
gdapter .bemre running the Play feature to display the New Hardware Wizard, Add New
etup Wizard, you will need . . .
to manually configure your Hardware Wizard, or Found New Hardware Wizard (depending on
network settings. your operating system).

If you are installing the adapter for use on a HomePNA or Power
Line (PLC) network, use the following instructions.

To set up your adapter by using Plug and Play

1. Connect the adapter to your computer by following the
appropriate instructions in Step 2 of the Typical Setup method
presented earlier in this chapter.

2. Turn on your computer and log on to Windows. Plug and Play
detects the newly connected adapter and starts the Hardware
Wizard.

3. Insert the Broadband Networking Setup CD-ROM into your CD-
ROM drive.

4. In the Hardware Wizard, specify the CD-ROM as the location to
search for the PCl adapter driver.
The wizard loads the network adapter driver into memory.

5. Restart your computer if the Hardware Wizard asks you to do so.
If the wizard does not finish, see Chapter 6.

6. If you want this computer to connect to the Internet, configure
your Internet settings based on the information provided by your
Internet service provider (ISP).

7. To make sure your adapter works correctly, do one of the
following:
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o If you are connected to the Internet, test your adapter by
opening your Web browser and visiting a Web site, such as
www.microsoft.com.

o If you are connected to another computer or an internal
network, test your adapter by accessing shared files, folders,
or printers on the network.

o If you are not successful with either of the previous tests, see
the troubleshooting topics in Chapter 6. For more information
about Plug and Play, see Windows Help.
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network tasks.

Using Your Network

After setting up your wired network, you can perform common
networking tasks, such as making files and printers available to
other computers, and playing multiplayer games. When you need
to check network settings or monitor devices connected to your
network, you can use the Microsoft® Broadband Network Utility.

This chapter describes how to:
o Log on to your workgroup.
o Perform common networking tasks.

o Secure your network.

Log On to Your Workgroup

After starting your computer, you must always log on to your network
to access shared files, printers, and other resources.

If your computer is running an operating system that displays the
Cancel button, do not click Cancel during the logon process, even
if you decide to leave your password blank. Doing so will prevent
you from accessing shared files and printers on the network. Make
sure that your workgroup name is visible in the logon screen, type
your password, and then click OK.

After you log on, you can perform certain networking functions,
such as accessing the Internet or opening shared files from
Microsoft Windows® Explorer. You do not need to open the
Broadband Network Utility to perform these tasks.

Do Not
Click Cancel




@ Important
Before you proceed, check
with your Internet service
provider about its policy
regarding Internet sharing.

[=) Note
For help using the file- and
printer-sharing options in
Windows XP, click Start, click
Help and Support, and then
type “ICS” in the Search box.

To log off and log back on to your network
1. Click Start.

2. Click Log Off. (Or, in Microsoft Windows 2000, click Shut Down,
make sure “Log Off” appears on the menu, and then click OK.)

3. Log on to your network.

After you log on to your network, you can perform certain network
functions, such as opening shared files from Windows Explorer.

Perform Common Networking Tasks

The information in this section will help you get started with the
following tasks:

o Allowing access to an Internet connection
o Allowing access to files and folders

o Allowing access to printers

o Sharing other peripheral devices

o Reading e-mail messages on your network

o Playing games on your network and on the Internet

Allowing Access to an Internet Connection

If you have a gateway or router on your network and a connection
to the Internet through a DSL or cable modem, the other
computers on your network can share that Internet connection by
using Internet Connection Sharing (ICS).

The procedure for accessing the Internet is the same whether your
Internet connection is shared through a base station (gateway or
router) or through ICS in Windows XP. In either case, each
computer on the network needs to have a Web browser, such as
Microsoft Internet Explorer.

About Internet Connection Sharing (ICS)

Internet Connection Sharing is a feature found in Windows 98 SE,
Windows Me, Windows 2000, and Windows XP that allows
computers on a network to access the Internet through a single
connection. If you use a Windows-based computer as your Internet
access point (or ICS host), that computer must be turned on and
you must be logged on to it for the other computers in your network
to connect to the Internet.

For more information, look up “Internet Connection Sharing” in
Windows Help.

The procedure for accessing the Internet is the same whether your
Internet connection is shared through a Base Station or through
Internet Connection Sharing in Windows.
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[S) Note

If you have Microsoft Windows
2000 or Windows XP, you
mightneed to have
administrative privileges (or
be the network administrator)
to share folders with others.
For more information, type
“administrator” in the Search
box in Windows Help.

To access the Internet from each computer on a network

1. Make sure that you have a Web browser (such as Microsoft
Internet Explorer) installed on each computer that is connected
to your network.

2. On any of the networked computers, open the Web browser.

3. Search for the Web site you want, or enter the address in the
Address bar.

Note that the rate at which you are able to send and receive data
over the Internet is highly dependent on many factors. Adding
another user to your Internet connection typically reduces the
speed of data transfer, but you are unlikely to notice the difference.

Allowing Access to Files and Folders

The information in this section provides general guidance for a few
basic file-sharing tasks. For more detailed instructions and
information about sharing files and folders, see Windows Help. To
access Windows Help, click Start, and then click Help (or Help and
Support in Windows XP).

To make it easy to share files and folders, all of your networked
computers should be in the same workgroup. For more
information, look up “workgroup” in Windows Help.

Sharing files and folders is a two-step process. You will need to:
1. Make the files and folders available to the network.

2. Use Windows (Network Neighborhood, My Network Places, or
Windows Explorer) to access the shared files and folders.

To make your files and folders available to the network

While setting up your broadband network, you might have chosen
to share all of your files and folders with the network. If you decide
that you want to share only some of your files and folders with the
network, you can use Microsoft Windows to specify which files and
folders to share.

You can share an entire drive with the network, or you can share
specific folders. Let’s say that you store photographs of your
children in a folder named “Kids” on your computer, and you want
to make the photographs available to your network. To do so, you
would share only the Kids folder and not the other folders on your
computer.

Only the computer users on your network will have access to the files
you share. At times, you might want to prevent users, such as your
children, from accessing particular folders and the files they contain.
If you want to increase the security of your shared files, you can
assign permissions and passwords to your files and folders. For
more information, look up “permission” and “access control” in
Windows Help. (In Windows Me, look up “controlling access.”)
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Although you can share files, printers, and other devices on your
network, you cannot share software programs, such as Microsoft
Word or Microsoft Excel. If each computer on the network has
those programs installed, you can share the files that you create
within those programs.

For a computer’s files and folders to be available to the network,
the computer must be turned on and logged on to the network.
Also, if the computer is turned on but in sleep mode, it will not be
accessible from the network. For more information, look up “power
options” in Windows XP Help, or “power management” in Windows
Me, Windows 2000, and Windows 98 Help.

To access and organize your files

Windows Explorer displays the hierarchical structure of files,
folders, and drives on your computer. By using Windows Explorer,
you can copy, move, rename, and search for files and folders. For
example, you can open a folder that contains a file that you want to
copy or move, and then drag the file to another folder or drive.

To open Windows Explorer, click Start, point to All Programs (or
Programs, depending on your version of Windows), point to
Accessories, and then click Windows Explorer.

You can use My Network Places (or Network Neighborhood, in
Windows 2000 and Windows 98) to view all of the shared files and
folders on your network.

My Network Places/Network Neighborhood presents a view of the
network similar to the view of your computer presented by Windows
Explorer. Use My Network Places/Network Neighborhood when you:

o Want to see all the resources available on the network.
o Already know where the resource that you want is located.

o Want to copy files and folders from one network location to
another.

To open My Network Places, click Start, and then click My Network
Places.

To open Network Neighborhood (in Windows 2000 and Windows
98), double-click Network Neighborhood on your desktop.

Before files or folders can be shared on your network, you will need
to do the following:

o Make the file, folder, or drive available to the network.

o Use My Network Places or Network Neighborhood to view and
access shared files and folders.

For a computer’s files and folders to be available to the network,
the computer must be turned on. If the computer is in sleep mode,
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it will not be accessible from the network. For more information,
type “power options” in the Search box in Windows Help.
To open a file stored on another computer on the network

To complete this task, you must have the program on the local
computer that was used to create the file. For example, if you want
to open a file whose file name extension is .xIs, you must have
Microsoft Excel on your computer.

1. Open My Network Places or Network Neighborhood. (See the
earlier instructions on how to open these windows.)

2. Double-click the name of the computer that has the file that you
want to open.

3. Locate the file that you want to open.

4. Double-click the file.

To copy a file from your computer to another place on the network

You need to open only one window -- either Windows Explorer, My
Network Place, or Network Neighborhood -- to complete this task.
Your computer and the computer you want to copy the file to will
both appear in the same window.

1. Open Windows Explorer, My Network Places, or Network
Neighborhood. (See the earlier instructions on how to open
these windows.)

2. On your computer, locate the file that you want to copy to
another computer on the network.

3. Click to highlight the file.
4. On the Edit menu, click Copy.

5. Click the destination folder on the other computer. (You might
need to scroll through the window to find the folder that you
want).

6. On the Edit menu, click Paste.
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[=) Note

Some printer drivers are not
designed to allow printer
sharing. For more information,
see the documentation that
came with your printer.

Allowing Access to Printers

By using Windows, you can print documents on a printer that is
attached to another computer on your network.

The following procedures provide general guidance for a few basic
printer-sharing tasks. The steps that you need to take to complete
these tasks will vary depending on the version of Windows installed
on your computer. For complete instructions and information about
sharing printers, type “printer sharing” in the Search box in
Windows Help.

There is a difference between a “network printer” and a “local
printer” that you share on a network. A network printer is
connected directly to the network, rather than to a particular
computer, and can be used by anyone on the network. Most offices
have network printers that are stored in copy rooms accessed by
many employees. A local printer, on the other hand, is attached to
a specific computer, but can be shared with other computers on
the network. You will most likely be using local printers with the
Broadband Network Utility.

Before you can use a printer that is attached to another computer
on your network, you will need to do the following:

o Make the printer available to the network (this is also known as
sharing a printer).

o Run the Add Printer Wizard on each computer that you want to
print from. This Installs the printer drivers on each networked
computer that will use the shared printer.

The procedures for sharing a printer and installing drivers differ
depending on your version of Windows. For more detailed
instructions, look up “sharing printers” in Windows Help.

To print to a printer that is attached to another computer on the
network

1. Open the document that you want to print, such as a document
in Microsoft Word.

2. On the File menu, click Print.

3. In the Print dialog box, select the shared printer from the list of
printers.

4. Click OK.
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Sharing Other Peripheral Devices

In addition to sharing most printers, you can share storage
devices—such as hard drives, CD-ROM drives, and Zip drives—on
your network. In general, any kind of drive represented by a drive
letter (such as D:\) can be shared.

Storage devices that are not assigned a drive letter (such as tape
drives) cannot be shared. Tape backups of your computer must be
done from the computer that is attached to the tape drive.

In general, scanners, cameras, and CD-ROM burners cannot be
shared with your network.

Reading E-Mail Messages

You can access your e-mail messages from each networked
computer the same way that you would access e-mail messages
without a network (assuming that you have an Internet connection).
Open your e-mail program, or, if you have a Web-based e-mail
account, sign in to your account through your Internet browser.

Keep in mind the following: If you download e-mail messages from
your e-mail account to one computer, those messages will not be
accessible from the other computers on your network. Likewise, if
you share an account with another person, and he or she
downloads mail from the shared account to one computer on the
network, you will not see that mail when you access the account
from another computer.

To illustrate this point, let’'s say you share a postal mailbox at your
home with your spouse. If you come home first and take the letters
out of the mailbox, they will no longer be inside the mailbox when
your spouse comes home later and checks for mail.

If you want your e-mail messages to remain available to all users of
your network at any time, you should not download the messages
to one computer. (However, you should delete old messages from
your e-mail account on a regular basis, so that you don’t exceed
the storage space given to you by your e-mail provider.)
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Playing Games on Your Network and on the Internet

Many of the most popular games now have multiplayer capability,
allowing two or more players to compete by using a local network.
With network-enabled games, you can use your networked
computers to play games with friends and family members.

Most games come with documentation that explains all you need to
know to configure your network for multiplayer gaming. However,
the following steps might help you prepare for playing games over
the network:

o If you have purchased a multiplayer game, be sure to install
it on each computer on the network that will be used for
playing games.

o If you are playing a Web-based game, you might also be required
to pay user fees or download game files to your computer. Be
sure to follow the directions provided on the Web site.

o Make sure that the network protocols necessary to run the
games that you want are installed on each computer on your
network. For more information, see the documentation that
came with your games.

o If you have problems connecting to a Web-based game, you
might need to configure the base station to work with the ports
that your game uses. For more information, see “Port
Forwarding” in Chapter 6.

For information about playing games on the Internet, and for other
game-related information, visit
http://www.microsoft.com/broadbandnetworking/.
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Secure Your Network

Protecting the data and programs on your network computers from
security threats, such as computer viruses and hackers, is very
important. The following sections provide general information about
steps you can take to protect your network.

< Important Protect Your Network from Computer Viruses

Because Windows XP Internet . . .
Connection Firewall (ICF) will Even with a base station (gateway or router) installed, your network

interfere with file and printer is still vulnerable to viruses.

sharing, do not enable ICF on i i i X i
virtual private network (VPN) To avoid having a problem with viruses on your network, consider

connection or on client the following suggestions:

computers. .
o Educate yourself about how viruses are commonly spread so

that you do not spread one yourself.

* Do not load a program from an untrustworthy source on one
of your network computers. E-mail attachments from people
you don’t know or files from the Internet or online bulletin
boards are particularly risky.

* Never open e-mail attachments that you are not expecting.

* Scan all floppy disks before copying or opening files from
them, or before starting your computer from them.

o Install an antivirus program on each computer on your network
and use it regularly to check your computers for viruses.
Remember to update the antivirus program on a regular basis.

o Learn the common signs of viruses: unusual messages that
appear on your screen, decreased system performance, missing
data, and inability to access your hard drive. If you notice any of
these problems on your computer, run your antivirus software
immediately to minimize the chances of losing data.
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Protect Your Network from Hackers

If you have not already done so, consider purchasing the Microsoft
Broadband Networking Wired Base Station to establish a security
layer between your network computers and the Internet. The
security mechanisms provided by the base station include a firewall
and Network Address Translation (NAT).

A firewall is a barrier that helps protect your network from
unauthorized visitors. Like an actual firewall built to help prevent
fire from spreading between adjoining buildings, computer firewalls
help prevent unauthorized communication between an individual
computer or group of networked computers and the Internet.

The firewall specifies what information can be communicated from
the computers on your network to the Internet, and from the
Internet to the computers on your network.

NAT hides the IP addresses of the individual computers on a
network from the Internet so that only the router’s IP address is
visible on the Internet. Hiding these addresses provides another
layer of protection against hackers trying to access the computers
on your network.
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The Broadband Network Utility

The Microsoft® Broadband Network Utility is automatically
installed on your computer when you install the Setup software.
Use it to check the status of your network or change your network
settings. The Broadband Network Utility also shows the devices
currently connected on your network.

This chapter describes how to:

o View computer, network connection, and Internet connection
status.

o View and change network settings.
o Update network software, drivers, and firmware.
To open the Broadband Network Utility, do one of the following:

o Double-click the Broadband Network Utility icon “" in the
Windows notification area of the tray.

o Click Start, point to Programs, and then click Microsoft
Broadband Network Utility.

[ Mwrmiati Breadband Frsu i Uiy

Network Status
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Your Computer Status
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Your Network Status

(This page will look different
if your network does not

use a base station.)

: s el Coresrtan
Connection Status

o i

Your Internet

Status of all computers and
devices in your workgroup



The following sections describe how to interpret status information
about your network and perform common tasks by using the
Broadband Network Utility.

For more detailed information about any of these tasks, see
Broadband Network Utility Help.

To Open Broadband Network Utility Help
1. Open the Broadband Network Utility.

2. On the Help menu, click Microsoft Broadband Network
Utility Help.

View the Status of Your Computer

This area of the Broadband Network Utility displays information
about the computer that you are currently using. If you cannot
access the Internet, or your network is not available, use the
troubleshooting link to go directly to the list of related topics. For
other network problems, on the Help menu, click Microsoft
Broadband Network Utility, double-click Troubleshooting, and
then click the topic that you want.

View the Status of Your Network Connection

This area of the Broadband Network Utility displays information
about your network connection. If there is a problem with your
connection, on the Help menu, click Microsoft Broadband
Network Utility, double-click Troubleshooting, and then click the
file that you want.

You can also view information about the status of your network
connection by resting the pointer on the Broadband Network Utility
icon < in the Windows notification area of your taskbar or tray.

% e ') fw, #:- 10:06 A

Broadband Network
Utility Icon
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View the Status of Your Broadband Internet

Connection

This area of the Broadband Network Utility lets you know whether
you are currently connected to the Internet. If there is a problem
with your Internet connection, on the Help menu, click Microsoft
Broadband Network Utility, double-click Troubleshooting, and
then click the file that you want.

View the Status of Other Network Devices

This area of the Broadband Network Utility displays information
about all the computers and devices in your workgroup.

To refresh the network device list

Right-click any icon in the network device list, and then click
Refresh.

To remove an inactive device from the network device list

Right-click the dimmed icon for the device, and then click
Remove from List.

View and Change Network Settings

You can view and change your adapter settings from the Broadband
Network Utility. If you have a Microsoft base station, you can also
use the Broadband Network Utility to view and change your base
station settings.

To view adapter settings
On the Tools menu, click Computer Settings.
To view and change base station settings
1. On the Tools menu, click Base Station Management Tool.

2. Type the base station password.

Customize the Broadband Network Utility

You can customize the way you view and use the Broadband
Network Utility.

To customize the Broadband Network Utility

On the Tools menu, click Options.
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Update Software, Drivers, and Firmware

Occasionally, Microsoft might provide upgrades to the Broadband
Network Utility software, network drivers, or firmware on the
Microsoft Broadband Networking Web site. When an upgrade is
available, you will automatically be notified. After you log on to a
networked computer, a message will appear in the notification
area of your desktop with a link to the Microsoft Broadband
Networking Web site.

To update network software, drivers, or firmware
1. Open the Broadband Network Utility.
2. On the Help menu, click Check for Updates Online.

3. Follow the instructions on the Microsoft Broadband Networking
Web site to download the most current software, drivers, or
firmware.
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=’ Note
To avoid electrostatic shock,
always disconnect the power
cable from your computer
when working inside the
computer case.

troubleshooting.

Basic Troubleshooting

This chapter will help you solve installation and setup problems
with your Microsoft® Broadband Networking Ethernet adapter. The
following areas are covered:

Setup and Hardware Problems
Network and Internet Problems
File and Printer Sharing Problems

If the problem you are experiencing is not covered in this chapter,
you can find more troubleshooting information in Broadband
Network Utility Help, or on the Microsoft Broadband Networking
Web site at http://www.microsoft.com/broadbandnetworking/.

Setup and Hardware Problems

This section will help you solve problems you might encounter while
running the Setup Wizard or connecting your new adapter.

I’m having problems installing the Broadband Network Utility.

Verify that your computer conforms to the minimum system
requirements for your Microsoft Broadband Networking adapter.

When you run the Setup Wizard, the Broadband Network Utility
is installed automatically. If your computer does not meet the
minimum system requirements, the software might not install
fully or at all.

After installing my PCI adapter, | cannot turn on my computer or
it goes into Safe Mode when Windows starts.

Verify that the PCI slots in your system are at least PCI 2.1
compliant. This information is listed in the manual that came
with your computer.

Verify that the PCI adapter is firmly connected to the PCl slot in
your computer. A partially connected PCl adapter might cause
your computer either to not turn on or to function erratically.

If you have another available PCI slot in your computer, try
moving the PCl adapter to that slot.

Try plugging the PCl adapter into PCI slot 1 in your computer. For
more information about which PCI slot is slot 1, see your
computer’s documentation.



Each PCI slot in your computer uses different system resources.
By trying a different PCI slot, you can remove potential resource
conflicts between your PCl adapter and other computer
peripherals.

o Resolve any device conflicts in Windows. You can use Windows
Troubleshooting to ensure that your PCI adapter is not trying to
use computer resources already being used by another piece of
hardware. For more information about resolving device conflicts,
see Windows Help.

The Setup Wizard or Windows is not detecting the connection to
my PCI adapter.

o Make sure that the cables in your network are securely fastened
to the correct ports, and your network card is properly seated in
the correct slot.

Check all of the following connections: power cables, cables
between the adapter and the network, and cables between the
network and the broadband modem.

Ethernet cables closely resemble standard residential telephone
cables. However, The RJ-45 connectors on Ethernet cables are
larger than the RJ-11 connectors on telephone cables. Although
a standard residential telephone connector can be inserted into
an Ethernet port, the port will not function and the cable might
damage your Ethernet device.

o Make sure that the status LED on your PCl adapter is illuminated
when connected to your network. If it is not illuminated, try a
different Ethernet cable or a different network port.

Network and Internet Problems

This section will help you solve common installation and setup
problems as you integrate the Microsoft Broadband Networking PCI
Adapter with a new or existing network.

The PCl adapter is designed to have the software installed before
the hardware; otherwise, the Setup Wizard will not correctly
configure your network settings.

If you replaced your previous network adapter with a Microsoft
adapter, make sure that you disabled all of your previous network
settings and removed all unnecessary cabling. When possible, use
the same cables to reconnect your computer to the network. Doing
so can help prevent connectivity problems.
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My computer recognizes my network, but it is not working
correctly.

o Verify that you have the correct network settings.

Incorrect network settings will prevent networked computers
from communicating properly. For example, a computer might
try to detect a network by using the wrong name or by using a
different communication protocol than that of all of the other
computers on the network. You can view and modify most
network settings in the Broadband Network Utility.

For more information about viewing and modifying your network
settings, search for “Network” in Windows Help.

My network connection works only occasionally.

o Verify that other devices running Network Address Translation
(NAT) or Dynamic IP (DHCP) have NAT and DHCP disabled.

Devices such as your modem might have NAT or DHCP running
at the same time as another network device, such as a base
station (gateway or router). If this is the case, the devices will
interfere with each other and cause intermittent failures. For
instructions about disabling NAT and DHCP on the other device,
see the documentation for the other device.

My network is slow.

o Try decreasing the number of computers that are
simultaneously accessing your network.

Your network has a limited amount of bandwidth for
transmitting data. As more computers access your network at
the same time, the bandwidth must be split up between all
computers. By reducing the number of computers accessing
your network, you can increase the bandwidth available to each
computer.

You might find that you need more bandwidth to use all of your
computers on the network. If your connection is still too slow,
you can contact your Internet service provider (ISP) to verify that
there are no problems with your connection or to inquire about
upgrading to a faster connection.

My computer can’t find my workgroup.

o Check the name of the workgroup in network settings on
another computer in the workgroup.

The workgroup name is on the Advanced Network Settings
screen, which you can access from the Customize Your Network
screen in the Broadband Network Utility.

If your computer can’t find your workgroup, it might be using the
wrong name to look for the workgroup or you might be logged on
to a domain. You cannot be logged on to a domain and a
workgroup at the same time.
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My existing network used to work, but now it doesn’t.

o Check the existing network installation to verify that all cables
are still attached and all link/activity lights on the other network
devices read correctly.

o Verify that the network settings on all of the computers are
correct.

For more information about replacing or integrating an existing
network with the Broadband Network Kit, see Chapter 4. For
more detailed information, see Broadband Network Utility Help.

I cannot access the Internet with my newly networked computer,
even though the Setup Wizard finished successfully. My other
networked computers can access the Internet.

If you have successfully completed the Setup Wizard to install your
adapter, but cannot access the Internet from the system with the
new adapter, you might need to configure your Internet settings for
access to your Internet service provider (ISP).

The troubleshooting steps necessary to fix your Internet connection
are different depending on what type of connection you have, so
the first step is to determine how you connect to your ISP for
Internet access. This information is available either in the
documentation from your ISP or by calling technical support for
your ISP and inquiring about your connection type. There are three
main broadband connection types:

Dynamic Host Configuration Protocol (DHCP) connections

DHCP is the most common type of broadband Internet access. By
default, the Setup Wizard configures your adapter to use DHCP. If
you are connecting your adapter to a base station (router or
gateway), you do not need to configure any additional network
information.

The following instructions will help you troubleshoot Internet
connection problems with DHCP:

o Try accessing shared files or printers on another computer on
your network. If you cannot access the other computers, check
to make sure all cables are connected between your computer
and the network, and the status light on your PCl adapter’s
mounting bracket is green.

o Try connecting the Ethernet cable from this computer to a port
on your base station, switch, or hub that is currently connected
to a computer that can access the Internet.

If your newly networked computer can connect to the Internet
when using another computer’s network port, there might be a
problem with one of the ports on your networking hardware.
Consult the documentation for the base station, hub, or switch
for troubleshooting steps particular to that hardware.
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Point-to-Point Protocol over Ethernet (PPPoE) connections

PPPOE is a connection type used by some DSL modems to access
the Internet through an ISP. If you use a PPPoE connection to
connect to the Internet, your ISP should have provided you with
special access software. This software will automatically connect to
the Internet by using the user name and password provided by your
ISP.

Check the documentation from your ISP to find out more about how
to install and configure the access software on your computer. You
will not be able to access the Internet without this software.

Static IP address connections

Some ISPs provide each computer on their network with a
permanent, or static, IP address, which uniquely identifies your
computer on the Internet. When you use a static IP addressing
scheme, each computer on your network requires a unique IP
address provided by your ISP. Because of this, the Setup Wizard
cannot automatically determine this static address and configure
your network for Internet access. The following section describes
the necessary steps for configuring a static IP address.

Before you begin, make sure that you have all of the configuration
information from your ISP, including a unique static IP address, a
gateway address, and one or two DNS server addresses for the
newly networked computer.

To configure a static IP address, follow the instructions for your
operating system.

Windows XP:

1. Click Start, click Control Panel, and then double-click
Network Connections.

2. Click the connection you want to configure, and then, under
Network Tasks, click Change settings of this connection.

3. On the General tab, under This connection uses the
following items, click Internet Protocol (TCP/IP), and then
click Properties.

4. Click Use the following IP address, and in IP address, type
the new static IP address you wish to assign to this computer.

5. Type 255.255.255.0 in Subnet mask.
6. Type the gateway address in Default gateway.

7. Click Use the following DNS server addresses, and in
Preferred DNS server and Alternate DNS server, type the
addresses of the primary and secondary DNS servers.

8. Click Apply or Close to save your new Internet settings.
9. Test your Internet connection by opening a Web page in your

browser.
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Windows 98, Windows 98 SE, and Windows Me:

1. Click Start, click Settings, click Control Panel, and then
double-click Network.

2. Under The following network components are installed,
click TCP/IP and then click Properties.

3. Click the IP Address tab in the TCP/IP Properties window.

4. Type the new IP address for this computer in IP address. For
guidelines on choosing an IP address, see “Computer-to-
Computer Setup” in Chapter 3.

5. Type 255.255.255.0 in Subnet Mask.

6. Click the Gateway tab, and type your gateway in New
Gateway.

7. Click Add to add your gateway.

8. Click the DNS Configuration tab, and in Primary DNS server
and Secondary DNS server, type the addresses of the
primary and secondary DNS servers

9. Click Apply or OK to save your changes, and then click OK to
quit the TCP/IP Properties window. When prompted, restart
your computer.

10. After Windows starts, try testing your Internet connection by
opening a Web page in your browser.

Windows 2000:

1. Click Start, click Control Panel, and then double-click
Network and Dial-Up Connections.

2. Double-click Local Area Connection.
3. On the Local Area Connection Status page, click Properties.

4. Under Components checked are used by this connection,
click TCP/IP and then click Properties.

5. Click Use the following IP address, and in IP address, type
the IP address.

6. Type the subnet mask and gateway addresses in Subnet
mask and Default gateway, respectively.

7. Click Use the following DNS server addresses, and in
Preferred DNS server and Alternate DNS server, type the
addresses of the primary and secondary DNS servers.

8. Click Apply or OK to save your changes, and then click OK to
quit the TCP/IP Properties window. If prompted, restart your
computer.

9. After Windows starts, try testing your Internet connection by
opening a Web page in your browser.
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File and Printer Sharing Problems

This section will help you solve common installation and setup
problems with sharing files and printers on your network. If you
installed your network hardware by using the Setup Wizard, file and
printer sharing might have automatically been configured for you,
depending upon your network configuration.

To learn how to add or share files and printers over your network,
see Chapter 4 and Windows Help.

I cannot access shared files over my network.

To share files between computers on your network, all computers
must belong to the same workgroup. Check the workgroup names
on each computer by using the following instructions.

Windows XP:
1. Click Start, and then click Control Panel.
2. Double-click System, and then click the Computer Name tab.
Windows 2000:
1. Click Start, point to Settings, and then click Control Panel.
2. Double-click System.
3. Click the Network Identification tab.
Windows 98, Windows 98 SE, and Windows Me:
1. Click Start, point to Settings, and then click Control Panel.
2. Double-click Network, and then click the Identification tab.

If you need to change your workgroup name on a computer, click
Change, and then type the correct workgroup name. After
restarting your computer and joining the new workgroup, try
sharing or accessing shared files again.

My printer is connected directly to my computer and is not being
recognized by other computers on my network.

Check to make sure that the printer is turned on.

Verify that the cable connecting the printer and the computer is
securely attached.

Try printing by using the self-test feature built into your printer.
Each printer’s self-test feature is slightly different. See your
printer documentation for specific instructions.

If the printer self-test does not work, see your printer
troubleshooting documentation for more information.

If the printer self-test works correctly, the problem might be with
your network connection or with your printer drivers.
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o Check to make sure all computers on the network have the
proper printer driver installed.

You can install the printer driver by opening the Printers page
in the Control Panel. If Windows prompts you for a driver disk,
use the driver disk that came with your printer. For more

information about configuring your printer, see Windows Help.

o Verify that all network cables between the computers and the
printer are securely connected.

You can check to see whether the network recognizes a
connection by inspecting the link lights associated with the
Ethernet ports on your hardware. When the cable is connected
successfully, the link light should be illuminated.

If one of your network cables is connected to a network port that
does not have an illuminated link light, there might be a

problem with the cable itself. Try using a different Ethernet
cable to make the connection.

My printer is connected directly to my network, and | cannot
access the printer from the computers on my network.

o Check to make sure that the printer is turned on.

o Verify that all network cables between the computers and the
printer are securely connected.

You can check to see whether the network recognizes a
connection by inspecting the link lights associated with the
Ethernet ports on your hardware. When the cable is connected
successfully, the link light should be illuminated.

If one of your network cables is connected to a network port that
does not have an illuminated link light, there might be a

problem with the Ethernet port or the cable itself. Try using a
different Ethernet cable to make the connection.

o Try printing by using the self-test feature built into your printer.
Each printer’s self-test feature is slightly different. See your
printer documentation for specific instructions.

If the printer self-test does not work, see your printer
troubleshooting documentation for more information.

If the printer self-test works correctly, the problem might be with
your network connection or with your printer drivers.
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o Check to make sure that all computers on the network have the
proper printer driver installed.

You can install the printer driver by opening the Printers page in
the Control Panel. If Windows prompts you for a driver disk, use
the driver that came with your printer. For more information
about configuring your printer, see Windows Help.

My networked printer is visible on the network, but it does
not print.

o Try resetting the printer. See your printer documentation for
instructions.

o If you are troubleshooting a printer that is connected directly to
the network, try printing a test page by using the printer’'s
diagnostic features. If the test page prints correctly, the problem
might be in the network or the printer networking settings.

o Check the program from which you are trying to print to ensure
that printing is enabled and the correct printer is selected.
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Getting Help

Visit Us on the Web

Please visit our Web site at
http://www.microsoft.com/broadbandnetworking/

Click Help in the Broadband Network Utility

Click Help in the Microsoft® Broadband Network Utility for detailed
troubleshooting information.

Technical Support

Product Name:
Microsoft® Broadband Networking PCl Adapter

Support Information Online:
http://support.microsoft.com/directory/productsupportoption.asp

In Canada, visit http://www.microsoft.ca/support/

Online Support:

Work with a Microsoft Support Professional over the Internet.
Submit your issue online:
http://support.microsoft.com/directory/onlinesr.asp

Phone Support:

Toll-free support for U.S. customers: (800) 936-3900. For customers
in Canada: (800) 668-7975. These numbers are only for support of
Microsoft Broadband Networking products. Please do not use
these phone numbers for support of other Microsoft products.

TTY Users:

Microsoft text telephone (TTY/TDD) services are available at
(425) 635-4948 in Washington state or (800) 892-5234
elsewhere in the United States. Call (905) 568-9641 in Canada.

Worldwide:
The support terms listed here are available in the United States
and Canada only.

Support outside the United States and Canada may vary.
For regional contact details, please visit
http://support.microsoft.com/default.aspx?scid=/international.aspx?

Conditions:
Microsoft’s support services are subject to then-current prices,
terms, and conditions, which are subject to change without notice.



Regulatory Information

United States Radio and TV Interference Regulations

This device complies with Part 15 of the U.S. Federal Communications Commission (FCC) rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

The Microsoft hardware device(s) that accompanies this software can radiate radio frequency (RF) energy. If not installed and
used in strict accordance with the instructions given in the printed documentation and software Help file, the device may
cause harmful interference with other radio-communications devices (for example AM/FM radios, televisions, baby monitors,
cordless phones, etc.). Any cable that is connected to the device must be a shielded cable that is properly grounded. There is,
however, no guarantee that RF interference will not occur in a particular installation.

Your Microsoft hardware device has been tested, and it complies with the limits for a Class B digital device in accordance
with the specifications in Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful RF interference in a residential installation.

To determine if your hardware device is causing interference to other radio-communications devices, disconnect the device
from your computer. If the interference stops, it was probably caused by the device. If the interference continues after you
disconnect the hardware device, turn the computer off and then on again. If the interference stopped when the computer
was off, check to see if one of the input/output (I/0) devices or one of the computer’s internal accessory boards is causing
the problem. Disconnect the 1/0 devices one at a time and see if the interference stops.

If this hardware device does cause interference, try the following measures to correct it:

" Relocate the antenna of the other radio-communications device (for example AM/FM Radios, televisions, baby
monitors, cordless phones, etc.) until the interference stops.

* Move the hardware device farther away from the radio or TV, or move it to one side or the other of the radio or TV.

* Plug the computer into a different power outlet so that the hardware device and radio or TV are on different circuits
controlled by different circuit breakers or fuses.

* If necessary, ask your computer dealer or an experienced radio-TV technician for more suggestions. You may find
helpful information in the booklet “The Interference Handbook” (1995), published by the FCC. The booklet is available
from the FCC at 1-888-CALL FCC or at http://www.fcc.gov/cib/Publications/tvibook.html.

Note

Any changes or modifications not expressly approved by Microsoft could void the user’s authority to operate this device.
For use with UL Listed and GS approved personal computers.

Not intended for use in machinery or industrial applications.

Tested to comply with FCC standards. For home and office use. Model Number: MN-100, MN-110, MN-120, MN-130, MN-
150, MN-500, MN-510, MN-520.

Microsoft Corporation

One Microsoft Way

Redmond, WA 98052-6399.
(800) 426-9400 (United States)
(800) 933-4750 (Canada)

Canadian Radiocommunication Regulations
This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe B est conforme a la norme NMB-003 du Canada.

46 Microsoft Broadband Networking PCl Adapter User’s Guide



Limited Warranty

PLEASE READ THIS MANUFACTURER’S GUARANTEE CAREFULLY TO UNDERSTAND YOUR RIGHTS AND OBLIGATIONS
MANUFACTURER’S GUARANTEE AND LIMITATION OF LIABILITY

NOTE: The following guarantee is not restricted to any territory and does not affect any statutory rights that you
may have.

The term “Hardware Device” means the enclosed Microsoft Hardware Device. This Manufacturer’s Guarantee does
not cover your data, or any separate software, whether or not packaged or included with the Hardware Device.

MICROSOFT GUARANTEE. Microsoft guarantees (this “Guarantee”) that on the day you receive the Hardware Device and
for the next two (2) years thereafter (a) the Hardware Device will be substantially free from defects in materials and
workmanship, and (b) any support services provided by Microsoft will be substantially as described in applicable written
materials provided to you by Microsoft, and Microsoft support engineers will use reasonable efforts, care and skill to solve
any problem issues. In the event that the Hardware Device fails to comply with this Guarantee, Microsoft shall either, at
Microsoft’s option, (a) repair or replace the Hardware Device or (b) return the price you paid for the Hardware Device (if any),
provided that you return the Hardware Device to Microsoft with a copy of your receipt of purchase. You may exercise this
remedy without charge, except that you are responsible for any expenses you may incur. This Guarantee is void if failure of
the Hardware Device results from any accident, abuse or misapplication. Any replacement Hardware Device shall be
guaranteed for the remainder of the original Guarantee period or thirty (30) days, whichever is longer. Microsoft shall not
be liable for any loss or damage that you could have reasonably avoided, for example, by backing up your software and
files regularly.

EXCLUSION OF ALL OTHER TERMS. YOU AGREE THAT THIS GUARANTEE IS YOUR SOLE GUARANTEE IN RELATION TO THE
HARDWARE DEVICE AND ANY SUPPORT SERVICES. MICROSOFT AND ITS SUPPLIERS MAKE NO OTHER GUARANTEES OR
WARRANTIES WITH RESPECT TO THE HARDWARE DEVICE, THE SUPPORT SERVICES AND ANY PRODUCT MANUAL(S) OR
OTHER WRITTEN MATERIALS THAT ACCOMPANY THE HARDWARE DEVICE. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW AND SUBJECT TO THIS GUARANTEE, MICROSOFT AND ITS SUPPLIERS DISCLAIM ALL WARRANTIES,
CONDITIONS AND OTHER TERMS, EITHER EXPRESS OR IMPLIED (WHETHER BY STATUTE, COMMON LAW, COLLATERALLY
OR OTHERWISE), INCLUDING BUT NOT LIMITED TO ANY (IF ANY) IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY AND FITNESS FOR PARTICULAR PURPOSE, LACK OF VIRUSES, LACK OF
NEGLIGENCE, LACK OF WORKMANLIKE EFFORT, TITLE, AUTHORITY, OR NONINFRINGEMENT WITH RESPECT TO THE
HARDWARE DEVICE, THE SUPPORT SERVICES AND THE PRODUCT MANUAL(S) OR OTHER WRITTEN MATERIALS THAT
ACCOMPANY THE HARDWARE DEVICE. ANY IMPLIED WARRANTIES THAT ARE NOT DEEMED EXCLUDED ARE LIMITED TO
THE ORIGINAL GUARANTEE PERIOD OR TO THE SHORTEST PERIOD PERMITTED BY APPLICABLE LAW, WHICHEVER IS
GREATER.

LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW AND EXCEPT AS PROVIDED IN
THIS GUARANTEE, MICROSOFT AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES WHATSOEVER
(INCLUDING WITHOUT LIMITATION, SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES, DAMAGES FOR
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHER PECUNIARY
LOSS, FOR PERSONAL INJURY OR FOR FAILURE TO MEET ANY DUTY INCLUDING GOOD FAITH OR REASONABLE CARE,
OR FOR NEGLIGENCE) ARISING OUT OF THE USE OR INABILITY TO USE THE HARDWARE DEVICE, EVEN IF MICROSOFT
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE MICROSOFT’S ENTIRE LIABILITY UNDER
ANY PROVISION OF THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR THE HARDWARE
DEVICE. THESE LIMITATIONS DO NOT APPLY TO ANY LIABILITIES THAT CANNOT BE EXCLUDED OR LIMITED BY
APPLICABLE LAWS. THE FOREGOING LIMITATIONS, EXCLUSIONS AND DISCLAIMERS SHALL APPLY TO THE MAXIMUM
EXTENT PERMITTED BY APPLICABLE LAW, EVEN IF ANY REMEDY FAILS ITS ESSENTIAL PURPOSE.

REGISTRATION. You need not return the registration card for this Guarantee to be effective.

BENEFICIARY. To the extent allowed by applicable law, this Guarantee is only made to you, the first user of the Hardware
Device, and there are no third party beneficiaries of this Guarantee. It is not intended for and does not apply to anyone else
(except as required by law).

GOVERNING LAW. If you acquired the Hardware Device in the United States of America, the laws of the State of Washington,
U.S.A., apply to this agreement. If you acquired this Hardware Device in the European Union, Iceland, Norway or Switzerland
then local laws apply. If you acquired this product in Canada, except where expressly prohibited by local laws, the laws in
force in the Province of Ontario, Canada apply to this agreement and each of the parties hereto irrevocably attorns to the
jurisdiction of the courts of the Province of Ontario and further agrees to commence any litigation which may arise hereunder
in the courts located in the Judicial District of York, Province of Ontario.

If you acquired this Hardware Device outside of the countries listed above, then local laws may apply.

QUESTIONS. Should you have any questions concerning this agreement, or if you desire to contact Microsoft for any reason,
please use the address information enclosed in this Hardware Device to contact the Microsoft subsidiary serving your
country, or visit Microsoft on the World Wide Web at http://www.microsoft.com.
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Limited Warranty Continued

VEUILLEZ VOUS ASSURER QU'APRES UNE LECTURE ATTENTIVE VOUS AYEZ BIEN COMPRIS L'ENSEMBLE DES DROITS
ET LIMITATIONS EXPOSEES DANS CETTE GARANTIE DU FABRICANT

GARANTIE ET EXCLUSION DE RESPONSABILITE DU FABRICANT

REMARQUE : La garantie ci-d n’est pas limitée a un territoire particulier, et n’infl en iére les
droits légaux dont vous disposez.

« Dispositif matériel » dési le dispositif matériel Microsoft ci-inclus. Cette Garantie du Fabricant ne s’applique pas a

vos données ou aux logiciels séparés, qu’ils soient ou non emballés ou inclus avec le Dispositif matériel.

GARANTIE MICROSOFT. Microsoft garantit (la « Garantie ») que pour une période de 2 ans a compter de la date de
réception : (a) le Dispositif matériel sera, pour I'essentiel, exempt de vices matériels et de fabrication ; et (b) tout service
d’assistance fourni par Microsoft sera, pour I'essentiel, conforme a la documentation imprimée applicable fournie par
Microsoft, et les ingénieurs du service technique de Microsoft feront des efforts raisonnables pour résoudre toute difficulté
technique. Dans I'éventualité ou le Dispositif matériel manque d'étre conforme aux stipulations de la présente Garantie,
Microsoft pourra, au choix de Microsoft, (a) réparer ou remplacer le Dispositif matériel ; ou (b) rembourser le prix que vous
avez payé pour le Dispositif matériel (le cas échéant), a condition que le Dispositif matériel soit retourné & Microsoft avec
une copie de votre recu. Vous étes libre d’exercer ce recours sans frais, a I'exception que vous étes seul responsable des
dépenses que vous encourrez. Cette Garantie est nulle si le défaut du Dispositif matériel est causé par un accident, un
traitement abusif ou une mauvaise application. Tout Dispositif matériel de remplacement sera garanti pour le reste de la
période de garantie initiale ou pour trente (30) jours, selon la plus longue de ces périodes. Microsoft n’est en aucun cas
responsable des pertes et dommages que vous auriez pu raisonnablement éviter en sauvegardant réguliérement vos
logiciels et vos données, par exemple.

EXCLUSION DE TOUTES AUTRES CONDITIONS. VOUS RECONNAISSEZ QUE LA GARANTIE CI-DESSUS EST VOTRE SEUL
RECOURS EN CE QUI CONCERNE LE DISPOSITIF MATERIEL ET LES SERVICES D’ASSISTANCE. MICROSOFT ET SES
FOURNISSEURS NE FONT AUCUNE AUTRE GARANTIE QUANT AU DISPOSITIF MATERIEL, AUX SERVICES D’ASSISTANCE ET
AUX MANUELS DE PRODUIT OU TOUTE AUTRE DOCUMENTATION IMPRIMEE ACCOMPAGNANT LE DISPOSITIF MATERIEL.
DANS TOUTE LA MESURE PERMISE PAR LA REGLEMENTATION APPLICABLE ET CONFORMEMENT A LA GARANTIE,
MICROSOFT ET SES FOURNISSEURS EXCLUENT TOUTE GARANTIE ET AUTRES CONDITIONS, EXPRESSES OU IMPLICITES
(PAR JURISPRUDENCE, DROIT COUTUMIER, SECONDAIRE OU AUTRE), Y COMPRIS, DE MANIERE NON LIMITATIVE, TOUTE
GARANTIE IMPLICITE DE QUALITE, D’ADEQUATION A UN USAGE PARTICULIER, D’ABSENCE DE VIRUS, DE NEGLIGENCE ET
DE DEFAUT DE FABRICATION, DE TITRE, D’AUTORITE OU D’ABSENCE DE CONTREFAGON EN CE QUI CONCERNE LE
DISPOSITIF MATERIEL, LES SERVICES D‘ASSISTANCE LES MANUELS DE PRODUIT ET AUTRES DOCUMENTS IMPRIMES
ACCOMPAGNANT LE DISPOSITIF MATERIEL. TOUTE GARANTIE IMPLICITE QUI N’EST PAS EXCLUE EST LIMITEE A LA
PERIODE DE GARANTIE D’ORIGINE OU A LA PLUS COURTE PERIODE PERMISE PAR LA REGLEMENTATION APPLICABLE,
S| CELLE-CI EST PLUS LONGUE.

EXCLUSION DE RESPONSABILITE. DANS TOUTE LA MESURE PERMISE PAR LA REGLEMENTATION APPLICABLE ET SAUF
STIPULATION CONTRAIRE DANS CETTE GARANTIE, MICROSOFT OU SES FOURNISSEURS NE POURRONT EN AUCUN CAS
ETRE TENUS RESPONSABLES DE TOUT DOMMAGE DE QUELQUE NATURE QUE CE SOIT (NOTAMMENT ET DE MANIERE
NON LIMITATIVE LES DOMMAGES SPECIAUX, ACCESSOIRES, INCIDENTS OU INDIRECTS POUR PERTES DE BENEFICES,
INTERRUPTIONS D’ACTIVITE, PERTES D’INFORMATIONS OU AUTRES PERTES PECUNIAIRES, POUR PREJUDICES
CORPORELS OU MANQUEMENT A TOUTE OBLIGATION (NOTAMMENT L'OBLIGATION DE BONNE FOI ET DE DILIGENCE), OU
POUR DES ACTES DE NEGLIGENCE, RESULTANT DE L'UTILISATION OU DE L'IMPOSSIBILITE D’UTILISER LE DISPOSITIF
MATERIEL, MEME S| MICROSOFT OU UN QUELCONQUE FOURNISSEUR A ETE PREVENU DE L'EVENTUALITE DE TELS
DOMMAGES. EN TOUT ETAT DE CAUSE, LA RESPONSABILITE TOTALE DE MICROSOFT AU TITRE DE TOUTE STIPULATION
DU PRESENT CONTRAT NE SAURAIT EXCEDER LE MONTANT QUE VOUS AVEZ EFFECTIVEMENT PAYE POUR LE DISPOSITIF
MATERIEL. CES LIMITATIONS NE S’APPLIQUENT A AUCUNE OBLIGATION QUI NE PEUT ETRE EXCLUSE OU LIMITEE PAR
LES LOIS EN VIGUEUR. LES PRESENTES LIMITATIONS ET EXCLUSIONS DEMEURERONT APPLICABLES DANS TOUTE LA
MESURE PERMISE PAR LA REGLEMENTATION EN VIGUEUR, QUAND BIEN MEME UN QUELCONQUE RECOURS NE
PRODUIRAIT PAS D’EFFET.

ENREGISTREMENT. Il n’est pas nécessaire de renvoyer la carte d’enregistrement pour faire valoir la présente Garantie.

BENEFICIAIRE. Dans la mesure permise par la réglementation applicable, la présente Garantie s’applique uniqguement a
vous, le premier utilisateur du Dispositif matériel, et aucun tiers ne peut devenir le bénéficiaire de cette Garantie. La
Garantie n’est pas destinée et ne s’applique pas a d’autres personnes que vous (8 moins que cela ne soit requis par la loi).

DROIT APPLICABLE. Si vous avez acquis le Dispositif matériel aux Etats-Unis, ce CLUF est régi par les lois de I'Etat de
Washington, Etats-Unis d’Amérique. Si le Dispositif matériel a é&té acquis en Union Européenne, en Islande, en Norvége ou en
Suisse, le droit local pourra, le cas échéant, s’appliquer. Si vous avez acquis le Dispositif matériel au Canada, les lois en
vigueur de la province d’'Ontario, Canada, s'appliqueront a ce contrat et chacune des parties aux présentes accepte les
tribunaux de la province d’Ontario, et accepte d’entamer tout litige li€ aux présentes dans les tribunaux situés dans le
District juridique de York, province d’Ontario.

Si vous avez acquis le Dispositif matériel en dehors des pays énoncés ci-dessus, le droit local pourra, le cas échéant, s'appliquer.

QUESTIONS. Pour toute question relative a ce contrat, ou si vous souhaitez contacter Microsoft pour toute autre raison,
veuillez vous reporter a I'adresse fournie dans la documentation accompagnant ce Dispositif matériel pour contacter la
filiale Microsoft desservant votre pays, ou consulter le site Internet de Microsoft a http://www.microsoft.com/.
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Technical Specifications

PCI Adapter

Standards

IEEE 802.3 Ethernet;

IEEE 802.3u Fast Ethernet;

IEEE 802.3x 100BASE-TX Flow Control;

IEEE 802.1 p/Q Quality of Service; PCI Bus 2.2 ACPI;
OnNow/PC 98, PC 99; DMI 2.0, Wired for Management 2.0

Host Interface

PCI Bus compliant to PCI spec 2.2; 32-bit

Network Interface

Ethernet IEEE 802.3 and 802.3u CSMA/CD;
Built-in RJ-45 connector;

Auto-negotiation 10/100 Mbps;

Full-duplex support

Data rate 10 and 100 Mbps, full- and half-duplex
Indicators Link/Activity LED combined

Power 5V @ 180 mA

Operating Temperature 0to40 °C

Storage Temperature -25 t0 60 °C

Humidity 10 to 95 percent non-condensing
Emissions FCC Part 15 Class B compliant; Canada ICES-003
Safety UL 60950 / CSA-C22.2 No 60950

Physical Dimensions

4.72” x 1.69” (119.9 x 42.9 mm) without mounting bracket

Weight

1.63 oz (46.1g)

Reference 49



System Requirements

To use the Microsoft Broadband Networking Ethernet PCI Adapter:
Personal computer with an available PCI slot

Personal computer with processor running Microsoft Windows 98, Windows 98 SE, Windows
Millennium Edition (Windows Me), Windows 2000 Professional, Windows XP Professional, or
Windows XP Home Edition operating system.

Additional requirements for using the Microsoft Broadband Networking setup wizard and
Network Utility:

Microsoft Internet Explorer 5.0 or later; setup will install Internet Explorer 6.0 browser
components if needed, but will not displace your primary browser.

28MB of available hard-disk space if you already have Internet Explorer 5.5 or 6.0; 132 MB of
available hard-disk space if you are installing Internet Explorer for the first time.

4x or faster CD-ROM drive

VGA or higher-resolution monitor

Recommended:
Microsoft Mouse or compatible pointing device

3.5” high-density disk drive
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100Base-T

10Base-T

802.11, 802.11b

802.3

access point

ad hoc network

adapter

base station

broadband connection

broadband modem

cable modem

CAT 5 cable

client

glossary.

This glossary contains common terms for wired and wireless
networking.

Also known as “Fast Ethernet,” an Ethernet cable standard with a
data transfer rate of up to 100 Mbps.

An older Ethernet cable standard with a data transfer rate of up to
10 Mbps.

A family of IEEE-defined specifications for wireless networks.
Includes the 802.11b standard, which supports high-speed (up to
11 Mbps) wireless data transmission. Microsoft® Broadband
Networking wireless products comply with the 802.11b standard.

The IEEE-defined specification that describes the characteristics of
Ethernet connections.

See wireless access point.

A solely wireless computer-to-computer network. Unlike an
infrastructure network, an ad hoc network does not include a
central base station, router, or gateway.

See network adapter.

A device (also known as a router or gateway) that acts as a central
point for networked devices, receives transmitted messages, and
forwards them. Microsoft Broadband Networking base stations can
link many computers on a single network, and can share a secure
Internet connection with wired and wireless devices.

A high-speed connection, typically 256 Kbps or faster. Broadband
services include cable modems and DSL.

A device that enables a broadband connection to access the
Internet. The two most common types of broadband modems are
cable modems, which rely upon cable television infrastructure, and
DSL modems, which rely upon telephone lines operating at DSL
speeds.

See broadband modem.

Abbreviation for “Category 5 cable.” A type of Ethernet cable that
has a maximum data rate of 100 Mbps.

Any computer or program that connects to, or requests the
services of, another computer or program on a network. For a local
area network or the Internet, a client is a computer that uses
shared network resources provided by a server.



client/server network

computer name

crossover cable

DHCP

dial-up connection

DNS

domain

driver

DSL

DSL modem

duplex

dynamic IP address

A network of two or more computers that rely upon a central server
to mediate the connections or provide additional system resources.
This dependence upon a server differentiates a client/server
network from a peer-to-peer network.

A name that uniquely identifies a computer on the network so that
all its shared resources can be accessed by other computers on
the network. One computer’'s name cannot be the same as any
other computer or domain name on the network.

See Ethernet cable.

Acronym for “Dynamic Host Configuration Protocol.” A TCP/IP
protocol that automatically assigns temporary IP addresses to
computers on a local area network. Microsoft Broadband
Networking base stations support the use of DHCP which,
combined with ICS, allows you to share one Internet connection
with multiple computers on a network.

An Internet connection of limited duration that uses a public
telephone network rather than a dedicated circuit or some other
type of private network. The Microsoft Broadband Networking
hardware does not support the use of a dial-up connection to the
Internet.

Acronym for “Domain Name System.” A data query service chiefly
used on the Internet for translating host names into Internet
addresses. The DNS database maps DNS domain names to IP
addresses, so that users can locate computers and services
through user-friendly names.

In a networked computer environment, a collection of computers
that share a common domain database and security policy. A
domain is administered as a unit with common rules and
procedures, and each domain has a unique name.

Within a networking context, mediates communication between a
computer and a network adapter installed on that computer.

Acronym for “Digital Subscriber Line.” A constant, high-speed
digital connection to the Internet that uses standard copper
telephone wires.

See broadband modem.

A mode of connection; full-duplex transmission allows for the
simultaneous transfer of information between the sender and the
receiver. Half-duplex transmission allows for the transfer of
information in only one direction at a time.

The IP address assigned (using the DHCP protocol) to a device that
requires it. A dynamic IP address can also be assigned to a router
by an ISP.
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encryption The process of encoding data to prevent unauthorized access,
especially during transmission. Microsoft wireless hardware relies
upon encryption to ensure that data transmissions cannot be
accessed by users outside the network. Also see WEP.

Ethernet A networking standard that uses cables to provide network access.
Ethernet cable A type of cable that facilitates network communications.

firewall A security system that protects a network from external threats,
such as hacker attacks, originating outside the network. A
hardware firewall is a connection routing device with specific data-
checking settings, that protects all of the devices connected to it.
The Microsoft Broadband Networking Base Station includes a
hardware firewall. A software firewall resides on a single computer,
protecting that computer from external threats. See Microsoft
Windows® XP Help for more information about the Internet
Connection software firewall.

firmware Software information stored in non-volatile memory on a device.
gateway See base station.

gateway address The IP address used when making a connection outside your
immediate network.

host name The DNS name of a device on a network, used to simplify the
process of locating computers on a network.

hub A device with multiple ports that serves as a central connection
point for communication lines from all devices on a network. When
data arrives at one port, it is copied to the other ports.

ICS  Acronym for “Internet Connection Sharing.” A software feature in
Microsoft Windows that allows computers on a network to access
online services through a single Internet connection. Microsoft
Broadband Networking hardware replaces software ICS.

infrastructure network A network configuration in which wireless devices connect to an
existing network.

Internet domain See domain.

IP address Acronym for “Internet Protocol” address. IP is the protocol within
TCP/IP that is used to send data between computers over the
Internet. An IP address is an assigned number used to identify a
computer that is connected to a network through TCP/IP. An IP
address consists of four numbers (each of which can be no greater
than 255) separated by periods, such as 192.168.1.1.

ISP Acronym for “Internet Service Provider.” A company that provides
individuals or companies access to the Internet.
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LAN

MAC address

Mbps

modem

NAT

network

network adapter

PC Card

peer-to-peer network

Plug and Play

port

Acronym for “local area network.” A group of computers and other
devices dispersed over a relatively limited area (for example, a
building) and connected by a communications link that enables
any device to interact with any other on the network.

Acronym for “media access control” address. The address that is
used for communication between network adapters on the same
subnet. Each network adapter is manufactured with its own unique
MAC address.

Abbreviation of “megabits per second.” A unit of bandwidth
measurement that defines the speed at which information can be
transferred through a network or Ethernet cable. One megabyte is
roughly equivalent to eight megabits.

A device that facilitates the transmission and reception of
information between computers.

Acronym for “network address translation.” The process of
converting between IP addresses used within a private network
and Internet IP addresses. NAT enables all of the computers on a
network to share one IP address. The Microsoft Broadband
Networking Base Station supports NAT, which provides an extra
layer of network security by masking the actual IP addresses of the
computers using a base station.

A collection of two or more computers that are connected to each
other through wired or wireless means. These computers can share
access to the Internet and the use of files, printers, and other
equipment.

Also known as a “network interface card” (NIC). An expansion card
or other device used to provide network access to a computer,
printer, or other device.

A peripheral that adds memory, mass storage, modem capability,
or other networking services to portable computers.

Also known as a computer-to-computer network. A network of two
or more computers that communicate without using a central
server. This lack of reliance upon a server differentiates a peer-to-
peer network from a client/server network.

A set of specifications that allows a computer to automatically
detect and configure various peripheral devices, such as monitors,
modems, and printers.

A physical connection through which data is transferred between a
computer and other devices (such as a printer, monitor, or
modem), a network, or another computer. Also, a software channel
for network communications.
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PPPoE

protocol

RJ-11 connector

RJ-45 connector
router

server

shared folder

shared printer

sharing

SSID

static IP address

straight-through cable

subnet

subnet mask

switch

TCP/IP

Acronym for “Point-to-Point Protocol over Ethernet.” A specification
for connecting users on an Ethernet network to the Internet by
using a broadband connection (typically through a DSL modem).
Microsoft Broadband Networking hardware supports PPPoE for
connections that require it.

A set of rules that computers use to communicate with each other
over a network.

An attachment used to join a telephone line to a device such as a
modem.

An attachment found on the ends of all Ethernet cables.
See base station.

A computer that provides shared resources, such as storage space
or processing power, to network users.

A folder on a computer that has been made available for other
people to use on a network.

A printer connected to a computer that has been made available
for other people to use on a network.

To make the resources associated with one computer available to
users of other computers on a network.

Acronym for “Service Set Identifier,” also known as a “wireless
network name.” An SSID value uniquely identifies your network and
is case sensitive.

A permanent Internet address of a computer (assigned by an ISP).
See Ethernet cable.

A distinct network that forms part of a larger computer network.
Subnets are connected through routers and can use a shared
network address to connect to the Internet.

Determines whether two computers on a network can
communicate with each other directly. Similar in form to an IP
address and typically provided by an ISP. An example of a subnet
mask value is 255.255.0.0.

A central device that functions similarly to a hub, forwarding
packets to specific ports rather than broadcasting every packet to
every port. A switch is more efficient when used within a high
volume network.

Acronym for “Transmission Control Protocol/Internet Protocol.” A
networking protocol that allows computers to communicate across
interconnected networks and the Internet. Every computer on the
Internet communicates using TCP/IP.
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UsB

USB adapter

USB connector

USB port

WAN

WEP

Wi-Fi

wireless access point

wireless network name

WLAN

workgroup

Acronym for “universal serial bus.” A hardware standard for easily
connecting peripherals to a computer system.

A device that connects to a USB port; the Microsoft Broadband
Networking Wireless USB Adapter is a type of USB adapter.

The end of the USB cable that is plugged into a USB port.

A rectangular slot in a computer into which a USB connector is
inserted.

Acronym for “wide area network.” A geographically widespread
network that might include many linked local area networks
(LANS).

Acronym for “Wired Equivalent Privacy,” also known as “Wireless
Security.” A wireless network encryption mechanism that protects
data transmitted over wireless networks. If you are operating a
wireless network, it is strongly recommended that you enable WEP.

A commonly used term to mean the wireless 802.11b standard.

A device that exchanges data between wireless computers and
wired computers on a network.

See SSID.

Acronym for “wireless local area network.” A network that
exclusively relies upon wireless technology for the device
connections.

A group of users working on a common project and sharing
computer files, typically over a LAN. A user who has a home
network that is not being controlled by a domain controller can be
a member of a workgroup.
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My Network Settings
Use this page to record your network settings.

Workgroup or domain name:

Base station password (if applicable):

Wide Area Network (WAN) Settings

Complete this section only if your network has a base station (gateway or router). You can
obtain this information from your Internet service provider (ISP). Your ISP might not require
all of the settings listed below.

Dynamic IP (DHCP) Settings
Complete this section only if your ISP uses a DHCP connection.

Host name (optional):

Adapter MAC address (optional):

Static IP Address Settings
Complete this section only if your ISP has assigned you a specific IP address.
Static IP address:

Subnet mask:

IP gateway address:

Primary DNS server:

Secondary DNS server:

PPPoOE Settings
Complete this section only if your ISP uses PPPoE with your DSL connection.

User name:

Password:

Service name (optional):
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